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Product Release Note
Release Note

1.1 Background / Environment

Oracle Financial Services Software Limited has developed Oracle Financial Services Lending and
Leasing Release 14.2.0.0.0 solution. The suite is a comprehensive, end-to-end solution that supports
Direct and Indirect consumer lending addressing the key pillars of a lending business - Origination,
Servicing and Collections enabling financial institutions to provide better service and minimize
delinquency rates through a single, integrated platform. It addresses each of the lending processes from
design through execution. Its mission-critical and robust architecture and use of leading-edge industry
standard products ensure almost limitless scalability.

1.2 Purpose

The purpose of this Release Note is to highlight the enhancements included in the Oracle Financial
Services Lending and Leasing Release 14.2.0.0.0

1.3 Product Summary

Oracle Financial Services Lending and Leasing Release 14.2.0.0.0 is built to meet various challenges
faced by financial institutions. It addresses each of the lending processes — from design through
execution. Its unique value lies in its ability to provide the business with predefined processes and a
world-class framework that takes care of business risk and compliance needs.

1.4 Release Highlights

The key highlight of this release is to fix the critical bugs and to enhance the industry specific
requirements.
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Enhancements
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Ref No

Enhancements

Description

OFSLL_PMG_INTERFAC
E_RQT 030

Deal Refresh from Route One

When financial details of an application are updated
and sent from Route One, the application should not
be duplicated and allowed to amend in the existing
application

OFSLL_PMG_INTERFAC
E_RQT 013

Equifax Identity Scan Add-on

Facility to process the ‘Identity Scan’ result segment
(in ASCII format) of Equifax ACRO File and ACRO
File Plus bureau reports and display the same as part
of ‘bureau’ tab of respective origination, servicing and
collection functionalities

OFSLL_PMG_RQT_058

Communication Changes

Changes in communication modes and choice of fax
numbers provided in Correspondence

OFSLL_PMG_RQT_121

Adverse Action Reasons

System should have ability to define the adverse
action reasons by applicant

OFSLL_PMG_RQT_112

Rescoring

Ability to restructure an approval as many times as
necessary and re-run the scoring and pricing logic
each time

OFSLL_PMG_RQT_110

Exceptions in Bureau
Attributes

Whenever Credit Bureaus provide exception reasons,
OFSLL system captures and displays the same

OFSLL_PMG_RQT _116

Dealer Comments Update

Requirement is to provide a naotification on the results
page in case dealer comments are added / updated
on any application

OFSLL_PMG_RQT _381

Super Summary Widget

Enhancement is to display collective details of
applicant required for decision making, in the
Summary tab in one screen without having to navigate
to multiple tabs.

OFSLL_PMG_RQT 434

Underwriting Compensation

Approved Buy rate is displayed in Underwriting >
Compensation. Tolerance can be defined by User
and override edits are provided to handle conditions
where Tolerance is not met with

OFSLL_PMG_RQT 427

View Application Button

Facility to open applications in view only mode is
introduced

OFSLL_PMG_RQT_430

Comment column in

A new ‘Comment’ column is introduced in
Underwriting > Stipulations subtab and existing

stipulations Comments column is renamed as ‘Description’
When financial details of an application are updated
OFSLL_PMG_INTERFAC and sent from DealerTrack, the application should not
Deal Update

E_RQT 003

be duplicated and allowed to amend in the existing
application
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1.5 Deal Refresh from Route-One

1.5.1 Description

This feature allows to update on previously submitted application using Route One add-on feature
titted, “Deal Update.” Deal update allows dealers to update an application by adding a co-signer,
co-applicant or to change previously submitted information without submitting another application.
The most important aspect of this feature is the ability to add collateral after an applicant has been
submitted.

For applications with Origination Stage Code from ‘Decisioned’ up to ‘Verified’, new Sub-Status ‘Deal
Update’ is introduced. System would apply this Sub-Status to the application and change the
Origination Stage Code to ‘Review’. Once Origination Stage Code reaches ‘Funded’, this change
would not be possible.

While sending the decision information, system should send the <DealUpdateAllowed> as Y, so that
Route One enables/shows “Deal Refresh” button in their portal to update the application with
financial and collateral information without creating the new application.

OFSLL application web service has been enhanced to receive updated deals from Route-One.

ORACLE’ & Wekome, RMACHARL +  Accesshiiy 1§ Sgnout O
Financial Services Lending and Leasing

| DashBoard Customer Service © Origination (3 0ose

Origination Result/Task Underwriting: 0000001372 Search Revien Requests (Pending: 0) = Quick Search -

7 Origination ,

. " Aop #
Sales Lead Appication ; gen | Biew | &t "
Simpe Applcaton Entry View = Format + E Freee  ifi Detach wiep | @ Overdeok 4] Warning 0K ! s
Application Entry & [ submit | g Clear
Undervriting o
. cination Stage Producer Contact | _

Fundng Dt dopE Status -t Producer ame |75 Existing Customer |Duplicate Appication |Contact Sales Agent branch | | —
Appication Retrieval /1572014 0000001372 APPROVED - DEAL UF REVIEW CA-0004: VOLKSW) (818) 8844444 N [ usHQ Req. 17,000.00
Seenario Andlysis « n v Advance

Appiication Documents
Image Maintenance

Req.Rate 4,0000

Req. Term 50
Reports Sunmary  Appicant  Request  Decision | Bweay | Contact  Colaterl | Comments | Tracng  Domment  Verficaton  Comespondence  Tools Grade B GRADE
Producers V1038

Vendors Decision Information ZEdt | [Eew | of hudt 2 0.8
View v Fomatv | B Freeze 5 Detach wap | @) 483 SelectPricng [z] [lcaiste | grescore Asset Decc 2016 JEEP VIRANGLER 441D

m

ﬂ [ Jourent Jerade [ Score]  Max Advance Ant | LTv1|Max Financed Amt] 1Tv2|  DecsonTem|  Deasion Rate| Approved Buy Rate| | R CON/RUBICONN
[ [ B GRADE & 17,000.00 0.5 17,000.00 0.8 ) 9.9800 20000 (= @
N B GRADE &7 £0,000.00 £00.00 £0,000.00 £00.00 2 13,9800 20000 ~/Change Status
. M 0
h Stahus | APPROVED - DEAL UPDATE[ |
Change Stat
System Recommendation Stipulations Ttemizations  Tradedn Rate Schedule Subvention Compensation Multiple Offers
Itemizations AEdt | [Even | of Audt T
View v Format v | [ Freeze i Detach wep | @ Mt
| [iemization [t/ [Requestedamt  |approvedamt  [DiscountRate Comment | "
1 v Dovi PAYMENT B 16,000.00 0.00 - e =
r—
Servicing ITM CASH SALES + 12,000.00 0.00 e *Sub E
| Collections ITM DOWN PAYVENT PAYOFF + 0.00 0.00 Tree
.
o/ WEP ITM DOVWN PAYMENT TRADEIN - 0.00 0.00 T
ITM CREDIT INSURANCE LIFE + 7500 0.00
>
Lo ITM CREDIT INSURANCE DISABILITY + 0.00 0.00 o
>/ Setup ITM INSURANCE GAP + 700 0.00 o i v
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1.6 Equifax Identity Scan

1.6.1 Description

Currently, OFSLL does not support the processing of ‘Equifax Identity Scan’ data segment received
as part of the ACRO File or ACRO File Plus credit report response. (ACRO stands for ‘Automated
Credit Reporting Online file’).

OFSLL is enhanced to parse the response file segment 4 (Identity Scan) to extract and save the
data into a new data store (DB table). Post saving the credit bureau report data into OFSLL tables,
‘[dentity Scan’ data would be displayed in the newly introduced tab ‘Add On’ between the existing
tabs ‘Credit Scores’ and ‘Bureau Report’. In the ‘Add On’ tab there is a separate ‘grid’ called ‘Equifax
Identity Scan’ to display the results.

Grid displays the ‘Alert Description’ (Note: ‘Addl Product’ should be configured as ‘Identity Scan’). If
Equifax returns the message ‘IDENTITY SCAN DID NOT DETECT ANY ALERTS’, the same is
displayed in the Grid.

1.6.2 Screen shot
Origination
Result/Task Underwriting: 0000001023 Search Review Requests (Pending: 0)
Application Z it | [E view | o audit
View ~ Format = @ Freeze % Detach «J Wrap m Override OK Warning OK
Dt App F Status Origination Stage Code ;ra ;Lﬂg:r Gelz Existing Customer E;g::g::rﬂn Contact Sales Agent
12/11/2014 0000001023 WEW-REVIEWREQUIRED REVIEW L. ebseans o on
LB N—— s
Summary Applicant Request Decision Bureau Collateral Comments Tracking Document Verification Correspondence Tools

Bureau Details P add | A edit | [Fview | o audit

IMPORTANT: Access to credit reporting agency systems is for authorized users and only for permissible purposes, Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable by a 52500 fine
and/or 1 year in Federal prison per occurrence

View = Format - E 17| Freeze %Detach Qﬂ Wrap Eh

Credit Bureau
Type Bureau #|Status Dt Report s App Ind
MAMUAL EFX 2 COMPLETED 12/15/2014 CREDIT REPORT W/BEACON Y
MAMUAL EFX 2 COMPLETED 12/11/2014 CREDIT REPORT W/BEACON Y

Applicant/Customer Details
View - Format + E 1| Freeze % Detach Qﬂ Wrap Eﬂ

Type First Name MI Last Name Status Birth Dt S5N Suffix Include Debt Fopulate Debt |4
4| ] >
Report Header
View - Format + E 1| Freeze % Detach Qﬂ Wrap Eﬂ
Bureau First Name MI Last Name S5N Birth Dt Report Dt onfile Dt Credit Report Id Best Match
3 Public Records Collections Fraud Messages Inquiries Also Known As Consumer Statements Credit Scres Add-On Bureau Report Exception

Equifax - Identity Scan
View ~ Format = @ Freeze % Detach (33 Wrap m

Alert Description
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1.7 Communication Changes

1.7.1 Description

This requirement handles two changes.
(i) Changes are made in origination module to suppo

In Origination > Correspondence > Letters tab, radio

Product Release Note

rt Ad-hoc Fax / E-mail functionality:

buttons for ‘Letters’ and ‘Fax’ are provided. This

facility enables the user to send letters/ fax through different modes like Email/ fax to Producer or ad-
hoc correspondence. User can add/ edit a record to send the correspondence to desired recipient

with comments appended in communication.

(i) Also a new system parameter is introduced ‘SALESAGENT_ MAIL _SEND_IND'.

If this

parameter is flagged Y’, system allows sending Fax/ Email messages to the Sales Agent also. Email

ID of the sales agent will be derived from user definit

1.7.2 Screen shot

ion screen.

Before taking changes, screen use to look likes this:

ORACLE & Welcome, RMACHARL ~  Accessbiity 1@ signout ‘O
Financial Services Lending and Leasing
> DashBoard Origination [3] Qlose
Origination ResultfTask Underwriting: 0000001486 Search Review Requests (Pending: 0) “ | ~IQuick Search o
7 Origination . . x
Erees Application ZEdt | Elven | 2 audit £E2e
o View v Formatv | B Freeze (i Detach wirap | @ Override ok [ Warning OK . =0
Application Entry Producer ~
g ot o # status Crgnation Stageorogucer ame Contact |misting Customer | Dupiicat Agpicaton Cantact Sales Agent Branch [ suomt | e
Funding iy L v/Summal
- [ 0s/02/2014 000001486 NEW - REVIEW REQUIRED REVIEW CA-00004 : VOLKSWAGEN OF (818)-884-44 N N 3 DEMOSALES usHQ. ry
Applici = — 5 Req. Advance 50,000.00
Scenario Analysis e 26T
;xuphcs:m n:mmems -
image Maintenance
— Dedision Bureau Contract Comment ts Tracking Document Verification Correspondence Toolk Grade B GRADE
= LTV 1 23248
Producers
V2 23248
Vendors
Letters »/Change Status
View v Format v Freeze Detach Wrar View Letter = E
4 & = o | @ Eyewtets | § e e e R
[ [correspondence |correspondence Type File Name: |
CNLNCE_ADV_LTR_VR ADVERSE ACTION LETTER. loradv_em_111 01 E TG
CNLNCE_ACO_LTR_VR. CONDITIONAL ADVERSE ACTION LETTER loraco_em_111_01
CNLNCE_CON_LTR VR CONTRACT FUNDING FAX/EMATL lorcon_em_100_02 ~/Add Comment
CNLNCE_DEC_FAX_VR DECISION FAX/EMAIL lordec_em_111_01 et
CNLNCE_DEC_MULTIOFFER_FAX_VR DECISION MULTI OFFER lordec_em_111_04
*Type
*Sub
Type
o * Comment
| Servicing
>| Collections
>l wEp L
>| Tools
— 113 A
>/ Setup -« 1. »

After taking changes, screen looks like this:

Origination (28] Close
Result/Task Underwriting: 0000001430 Search Review Requests (Pending: 0) ~|Quick Search
Application & Edit =l view | < audit Dy £
View - Format ~ | B Freeze i Detach Wrap @ overide ok Narning OK SSN
- atus Origination 5tage  |p,0duce Producer Contact isting Customer | DuPlicate — ales Agen B &
= s S Code Foxi Number Soooges Application st Zieuaait s
I 01/02/2015 0000001430 NEVY - REVIEW RE... REVIEW CA-00005 : AUTO . (818)-768-2100 N N GEMOSUPR ey
»
Reg. 50,000.00
Advance
Req. Rate 7.0000
Summary Applicant Request Dedision Bureau Collateral Comments Tracking Document verification Correspondence Tools Req. 36
Term
Correspondence Letters Grade
LTV 8333
Letters
LTv2 8333
v Letters @) Fax
Asset 2015 HONDA
Desc ACCORD
View - Format - | Ep Freeze i Detach wrap T 5] View Lotter vileage 0
Corraspondence | Correspondence Type |File rame ~/Change Status
-CNLNCE,AOO,LTR,VR CONDITIONAL ADVERSE ACTION LETTER leraco_em_111_01 S DET-EEEEITE
CNLNCE_CON_LTR_VR CONTRACT FUNDING FAX/EMAIL lorcon_em_100_02 Status - - g
CNLNCE_DEC_FAX_VR DECISION FAX/EMAIL lordec_em_111_01 Change Statu
¥ »
L Add Comment
Recipient Details =4 add | 2 Edit El view | <2 audit = Alert
view - Format v | Ep Freeze i Detach wrap (5] send Thype [
Recipient |Mode | Type | Fax/Email |sent Indicator Comments | Sub [
|| 8187678329 N Type
* Commen t
Recipient Details
& save and add | save and stay | [ save and Return |_ <3 Return
“ Recipient [PRODUCER select the mode = Type Comments
= Mode [Fax T FaX/Email UNDEFINED “ Past Comme
[EMmar
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1.8 Adverse Action Reasons

1.8.1 Description

Product Release Note

System is enhanced to capture the adverse action reasons at the applicant level. In Underwriting >

Decision > Stipulations tab, new field ‘Applicant’'s Name’ is introduced.
display applicant(s) name attached to the respective application. User
and record the adverse action reasons at each applicant level.

1.8.2 Screen shot

Before taking changes, screen use to looks like this:

This is a dropdown that would
can select the Applicant Name

LivALLE . . . @& Welcome, RMACHARL ~  Accessbiity @ SignQut €
Financial Services Lending and Leasing
ongination [x)close
ovgination Sia Producer
ot App # Status coge 9% |producer Name Contact |Existing Customer  [Dupiicate Appiication |Contact Sales Agent Branch Product Channel Pricrity Comg
Number B
[ os/oz/2014 0000001486 NEW - REVIEW REQUIRED REVIEW (CA-00004 : VOLKSWAGEN OF (818)-884-44N N K DEMOSALES usHQ LOAN UNSECURED (V WEB ENTRY. NORMAL uso1
<« i, ] »
Summary | Appicant | Request  Decision | Bueau | Contact  Comments | Traking = Doament | Verifiaon | Corespondence | Tools
Decision Information A Edit | ] View | o Audit
view v Format > | B Freeze ifiDetach | ol Wrap W g3 selectPricng [=] [0 calcuate
Elcwen [arade I score] M Advance Amt] (71| o Franced | 2| DecsonTem|  Deasengate oy Rate Pt | Down Pt uncerrterJpriang ]
.V 'BGRADE 0 13,949.00 23298 13,949.00 23248 60 0.5115 0.0000 235.52 0.00 RBOINA CN_LN_UNSECURED_
N 0 50,000.00 833.33 50,000.00 833.33 60 4.9900 2.9900 943.39 0.00 PHACHODA VEHICLE LOAN PRICT
< " ] f
:‘ System Recommendation Itemizations Rate Schedule Subvention Multiple Offers I} j
Stipulations dpadd | LEdt | [Fuew | o aut |
View  Fomat~ | B} Freeze EfiDetsch | o wirap ) e Load stipuistions | [[E] Copy Stpulations
[ [ryee |code Comment. |stips satisfied |verified By | verified Dt |
lsmunmuasms (CON-006. WOULD CONSIDER AS AN INDIVIDUAL REQUEST NA
STIPULATION REASONS APP-002 PROVE EMPLOYMENT Yes @ No (7) NA
STIPULATION REASONS APP-004 RESIDENCE MUST VERIFY AS STATED FOR APPROVAL TO BE VALID Yes @ No () NA
STIPULATION REASONS APP-012 NO GAPS IN EMPLOYMENT Yes@ No O NA
STIPULATION REASONS APP-007 CAUTION: APPROVED AT ANOTHER DEALER. Yes @ No (0 NA
ADVERSE ACTION REASONS ~ ADV-002 INSUFFICIENT CREDIT REFERENCES Yes @ No ) NA
After taking changes, screen looks like this:
ORACLE & Welcome, PHACHODA ~  Accessibility *3 Sign out
Financial Services Lending and Leasing
Origination 3] Close
Result/Task Underwriting: 0000001430 Search Review Requests (Pending: 0) ~IQuick Search
Application & Edit |_[E] view | 2 audit Ak
View > Format~ | [ Freeze f Detach ol wrap T  override 0K Warning OK SSN
- . Origination Stage Producer Contact " - Duplicate ) % b
JDt App # Status o Producer Name Soa Bxisting Customer | UBiRE Contact Sales Agent [ submit | &
[ 01/02/2015 0000001430 NEW - REVIEW RE... REVIEW CA-00005 : AUTO ... (B1B)-768-2100 N ] DEMOSUPR R
»
Reg. 50,000.00
Advance
Req. Rate 7.0000
Summary Applicant Request Decision Bureau Collateral Comments Tracking Document Verification Correspondence Tools Req. 36
Term
Decision Information Z Edit | 5] view | o audit Grade
; . o LTV 8333
View v Format - | P Freeze i Detach ol wrap B Srselectprang | [ v] [ calalate 3 Re-Score
LTV2 8333
qurrent Grade Score|  Max Advance Amt| L'rv1| Max Financed Amt. LTV2| Decision Term Decision Rate| Approve Asset 2015 HONDA
Desc ACCORD
HE 0 50,000.00 8333 50,000.00 83.33 24 9.9800 Mileage 0
»
~/Change Status
s NEW- "
System Recommendation Stipulations Itemizations Trade-In Rate Schedule Subvention Compensation Multiple Offers SEirn A= HEEE
Change Statu
fl Stipulations
I8 save and stay | [ save and return |_<Ga geturn :lv Add Comment
View ~ Format~ | B Freeze " Detach Wrap [50] * Alert
L [Type Hame . | | Description Stips Satisfied |comment “Type [
Displays Applicant name
STIPULATION REASON ¥ ALL APP-002 =| | PROVE EMPLOYMENT Yes o) No ) NA 75:2
¥
SAMES LEE Comment
STIPULATION REASON ¥ MARY LEE APP-006 =] |NEED TAX RETURNS WITH § Yes @ No () NA
RALPH LEE
[sTPuLATION REASOR ¥ | APP-012 =| [NO GAPS IN EMPLOYMENT Yes @ No () NA
Post Comme
[sTIPULATION REASON ¥ | APP-004 x| [RESIDENCE MUST VERIFY A Yes @ No () NA
»
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1.9 Rescoring

1.0.1 Description

Product Release Note

In the Decision tab, a system recommended score is displayed, which is calculated using internal
scoring models defined in the system. The enhancement is to allow ‘Rescore’ and revise pricing
whenever any of the parameters influencing the scoring like Requested Amount, Income etc. are
changed by the User. This ‘rescore’ can be initiated by underwriting > Decision screen itself.

Whenever such information is changed by the User for a Loan application, system displays a warning

— ‘Scoring Sensitive Information is changed.

Please rescore the Application’. This is controlled by

flagging the system parameter ‘SCORING_PARAMETER_ALERT’ to ‘Y’ or ‘N’.

User can click on the ‘Rescore’ button displayed in the Decision tab which will display the revised

Score and respective Grade of the Applicant.

Drigination E
e [y Lo sty wew L e e e AL T L R v
« | m r
Summary Applicant Request Decision Bureau Collakeral Comments Tracking Docurnent WeriFication Correspondence
Decision Information AEdt | Even | o auit |
View + Format » % Freeze ﬁj‘ Detach Wap @ﬂ Select pricing
Current Fricing Deecision Dt Underwriter Status Sub Status Index Al IS AL Approved Rat
Rate Rate
. i DEFALLT PRICING-LC 08/02/2013 Jom PRIME RATE §.9900 4.95900 13,980
i DEFALLT PRICING-LCO1/26/2013 UMDEFINED APPRCYED AUTO AFPROVED  PRIME RATE 59,9900 +,9300 13,980
4| m k
System Recommendation Stipulations Ttemizations Trade-In Multiple Offers
System Recommendation
Score 858 Decision  AUTO APPROVED Grads & GRADE
/B Warning <]
Messages for this page are listed below. I
/2 1 . g . . . r . .
/2 'Scoring sensitive information is changed'. Please rescore the application
= ) :
@ Transaction Completed Successfully.
Origination (3 Qlo=e
Result/Task Underwriting: 0000000600  Search h Review Requests (Pending: 0) it
Application 4 warning L Zedt |_[Fvew | o audt |
view v Format + | [EH| recze ff{Detach | ol wrap B Override Ok [B] Warring OK B oo tor e bace are tsted below. L
¢ | | \ \ i | | \ \ \
Jox Jroo# [staue [Srnation 2= oo corvame [ = e Agen [ovanen [proauc lcnannel ey Jcon
W oipifz012 0000000800 NEVY - REVIEW REQU REVIEW MN-D000 1 1 IN HOLIS (852)-4 oK LG LOAN VEHICLE (FR) WEB ENTRY NORMAL o2
[ . s
Summary  Appicant  Request  Decisin Burcau Colateral  Comments Trackng  Document t Verican Correspondence Toolz
Decision Information ZEdt | [Hyew | o auan |
View = Format = | [ ze [if{petach wep | @) [=] [0 caiate | 2Re-Score
1 Elowe [arade [ el Crva| ax Fnanced Ami] U1va|  DecsonTerm|  Decision Rate] Approved Buy Rate Pt Amt Down Pt [urgerniter = [pricng ] ‘
e D GRrace 150 10,000.00 100.00 10,000.00 100.00 8 12,9800 2.0000 178 0.00 RMACHARL DEFAULT PRICINGC
ol " '
Sstem Recommendation  Stpulstons  Ttemzatons  Tradedn  RateSchede  Subvention mpensat Multple Offers
System Recommendation
eeeee 150 Deciion AUTO REJECTED Grade D GRADE
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1.10 Exceptions in Bureau Attributes

1.10.1 Description

A new sub tab — ‘Exceptions’ is introduced in Bureau tab in Origination and Servicing. Whenever
Credit Bureaus provide exception reasons, the same is being captured and displayed by OFSLL in
the Exceptions sub tab. Exceptions received from each Bureau and each applicant is shown against
respective bureau exceptions or comments only.

1.10.2 Screen shot

Screenshot showing exceptions at origination > Bureau Tab

Origination (3] Qose

Summary  Appliant | Request  Dedson  Burcau | Contect  Colatrdl  Commens  Tradig  Dowment  Verfiafn | Coespordence | Toos

Bureau Details View | o Audt

IMPORTANT: Access to credit reparting agency systems is for authorized users and only for permissible purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable by a $2500 fine and/or 1 year in Federal prison per occurrence

B | Mfreee Givetnch | oJuran ‘ o))

View v Format v

Credit Bureau

Type Bureau #[status Dt Report e AppInd

INITIAL 2 COMPLETED 1jo4/2014 CREDITREPORT W/FICO

INITIAL u's 1 COMPLETED 11/04/2014 CREDITREPORT
Applicant/ Customer Details

View Fomat v | B | [ Freeze  etach | o wrap ‘ )]

Type First Name v Last Name Status Birth Dt ssh Suffix Indude Debt|  Populate Debt |Address Type Country Address # city st

N = I O 7 1 e I I N =<} (o= S Tl
« 1l J V

Report Header

View ~ Format +

B | []Fresze Hfivetach | oJlwiap ‘ m
ureau Fist eme Mt LastName B Brth ot ReportDt onfle Dt CreditReport T4 BestMatch

AddOn  BureauReport | Exception

Exception/comment
B | []Fresze fivetach | oJlwiap ‘ m

[Excepton/Comment |

View ~ Format v

Bureau Indicates a Possble Current Delinguency

Screenshot showing exceptions at servicing > Bureau Tab

Customer Service [ e
Account(s): 20141100010080: SFDF SADSD view | o audt | (4]
View + Format + ‘ B | (Freeze Hivetach | (Jwirap ‘ WM & @ curent© show All O Group Follow-up
Company Branch Account # Product currency Pay OFf Am| Amount Due Status (Oldest Due Dt
Summary  CustomerSeice | AccountDetsls | CustomerDetsls  Transaction History Pt Modes Barkriptcy  RepofForecosure  Defidency | Colsteral Bureau

Bureau Details G add | AEit | [ ven | Audt

IMPORTANT: Access to credit reporting agency systems is for authorized users and only for permissble purposes, Unauthorized access is prohibited nder the Fair Credit Reporting Act and is punishable by 2 $2500 fine andor 1year in Federal prison per occurrence
View v Format + ‘ B | MFreeze ipetach | Jwiap ‘ @) ViewReport @ Servieng © Origination

(Credit Bureau
(Type Bureau #|status Dt Report Reorders App Ind |Exception/Comment

Applicant/ Customer Detail
Vew « Fomat v | B | [IFreere [fipemn | v | @ 1
Type First Name ur Last Name Status girth Dt ssn Suffix Address Type Country Address # aty state StrestPre st
« n J B
I
Bureau Report
View = Format = ‘ & | [fes Hipetm | oI wiap ‘ @ G PintReport |
|Text
I
Vew v Fomat - [ | || Frecze Plivetsn | olvnop | @
|Exception/Comment I
Bureau Indicates a Possble Current Delinguency HE]




1.11 Dealer Comments Update

1.11.1

Description
A new column is introduced in the search results page — ‘CRITICAL’.

Product Release Note

The results page shows all the applications in User's queue. Whenever an application is
updated by Dealer, system displays an Alert symbol in this column to indicate that an update
is received for the respective application.

Also whenever a comment is posted with ‘Alert’ checkbox selected;

displayed in the ‘CRITICAL’ column for the respective application.

1.11.2

Screen shot

the Alert symbol is

Origination (28] Clox
Result/Task Underwriting: 0000000600 Search Review Requests (Pending: 0) =
Quick Search
App # SN EB Submit
Queue [=] Next Application
() Open Application \ 5] view Appiication \ B Unlock Appiication \ [5) Cony Appiication \
Search Results
View + Format = Freezz pfDetach | oJwap | G vewal
|critlLoc|alo|company  [Branch |app # |pate |Title |Product |status |substatus |Queue Name |erve |Lrv2
@ usot UsHQ 0000001317 11/01/2013  UNDEFINED LOAN VEHICLE FR) NEW BLANK DATA ENTRY APPLICATIONS QLD 0 -l
@ st uso2 0000001257 10/20/2014  BABUDHAYAKAR  LOAN VEHICLE (FR) NEW REVIEW REQUIRED NEW APPLICATIONS QUEVE 0 0
| @ usot UsHQ 0000001307 13/01/2014  DEMDEM LOAN VEHICLE (FR) NEW REVIEW REQUIRED NEW APPLICATIONS QUELE 416,66 416.66
@ usot UsHQ 0000001315 12/02/2014  DIESELVIN LOAN VEHICLE FR) NEW BLANK DATA ENTRY APPLICATIONS QLD 0
@ moo1 MR1 0000001318 08/20/2014  RAKRR LOAN VEHICLE (FR) APPROVED BLANK APPROVED / CONDITIONED APF 100 100
LSO LISHO 0000001319 120022014 BAWAT AK LOAN VEHICLF (FR) NEVY BLANK DATA ENTRY APP TCATIONS QL0 0
I @ uso1 USHQ 0000001296 11/27/2014 PATEL PRIYA LOAN VEHICLE (FR) NEW REVIEW REQUIRED NEW APPLICATIONS QUEUE 0 0
E! usot USHQ 0000001305 12/01/2014 GD LOAN VEHICLE (FR) NEW BLANK DATA ENTRY APPLICATIONS QLO 0
e usot USHQ 0000001313 12/01/2014 MANGINENI AJITHA LOAN VEHICLE (FR) APPROVED FUNDED FUNDED APPLICATIONS QUEUED 0
e usot USHQ 0000001328 12/03/2014 MAC RAJESH LOAN VEHICLE (FR) APPROVED FUNDED FUNDED APPLICATIONS QUEUE 12 12
e usot USHQ 0000001329 12/04f2014 MAC HARRY LOAN VEHICLE (FR) APPROVED FUNDED FUNDED APPLICATIONS QUEUE 100 100
@ usot USHQ 0000001254 11/25/2014 DEM DEMO12 LOAN VEHICLE (FR) NEW REVIEW REQUIRED NEW APPLICATIONS QUEUE  416.66 416.66
@ usot USHQ 0000001295 05/03/2014 COMENSATION TEST LOAN_VEHICLE APPROVED REHASHING REHASH APPLICATIONS QUEUED 0
e usot USHQ 0000001298 02/14/2014 DIESEL VIN LOAN VEHICLE (FR) NEW BLANK DATA ENTRY APPLICATIONS QLO 0 7‘ L4
@ usot USHQ 0000001312 02/02/2014 RANJAN MANO LOAN VEHICLE (FR) NEW REVIEW REQUIRED NEW APPLICATIONS QUEUE 58.82 58.82
@ st usHQ 0000001320 12/02/2013  BOINARAKESH  LOAN VEHICLE (FR) NEW REVIEW REQUIRED NEW APPLICATIONS QUEUE 12071 120,71
@ usot usHQ 0000001303 11/28/2014  UNDEFINED LOAN VEHICLE (FR) NEW BLANK DATA ENTRY APPLICATIONS QL0 0
@ usot usHQ 0000001314 1201/2014  123TEST LOAN VEHICLE (FR) APPROVED FUNDED FUNDED APPLICATIONS QUELED 0 -
< m ] » <
Origination [®]Close
Result/Task Underwriting: 0000001296 Search Review Requests (Pending: 0) =
Application At | Buen | o At
View v Format @ Freeze [iDetach | (Ivirap | Q) Overideok LY wamingo 1
Or ition Sta Prodi Contact
bt pp = Status C;‘i”“ SIS0 o odcer Name: Nru”m;:' O e sting Customer | Duplicate Application |Contact Sales Agent Branch Product Channe! Prioity Comy
11/27/014 0000001236 NEW -REVIEW CA0004: VOLKSW) (B1B}-B84-444 N N DEMOSUPR sk LOAN VEHICLE (FR) WEBENTRY NORMAL usot
| . ] 3
Summary Applcant Request Dedision Bureau Colateral Comments Tracking Document. Verification Correspondence Tools
Comments dpadd | At | Evien | of Audt
View v Format » | B Freeze GfiDeach | Jwap | B
:I Alert ype [sbType |comment | comment By | Comment bt | J
4
|3 LOAN CRIGINATION TSETING ‘SURADESA 1272014 12:20:59 AM
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Product Release Note

1.12 Super Summary Widget

1.12.1 Description

The summary screen widget has been changed to display fields on User’s Personalization. The
widget called ‘Super Summary’ presents relevant fields for selected product type ‘Loan/ Lease/ Line’.

It contains Applicant’s personal information, Employment details, Ratios, Bureau responses,
Application stage related information like Requested details, Decisioned Details, Contract Details and
Collateral Details.

Depending on the stage of the application, User can verify Applicant and Employment details from the
Super Summary Widget; which stamps the verification details of address/ employment in respective
tabs. Once these details are verified for any applicant, buttons will be disabled.

1.12.2 Screen shot
Summary Applicant Request Decision Bureau Collateral Comments Tracking Document Verification Correspondence Tools
~| Super Summary
Super Ssummary
Applicant MLMM Requested
Relation Type PRIMARY SPOUSE Req. Advance 50,000.00 Pmt Amt 0.00
Name JAMES LEE MARY LEE Req. Term 36 Down Pmt  0.00
SSN oc-ioo-B989 008989 Req.Rate 7.0000
Birth Dt 10/10/1982 10/10/1982 Decision
Address 7888 N 898989 BCH N # 89398 7888 N 898989 BCH N = 89898 -
TESTBRAINTREE MA 02184US  TEST BRAINTREE MA 02184 US Max Financed Amt Pt Amt
Own or Rent  RENTS APARTMENT RENTS APARTMENT Term Dowin Pt
Stated Amount(Monthly) 1,200.00 12,000.00 Rate(%) L1
Actual Amount{Monthly) 0.00 0.00 Approved Buy Rate(%) LTz
Stated Time at Residence{Y 6/ 6/6 Score Grade
Actual Time at Residence{Y¥/MM) 0/0 0/0
= Contract
M‘ Amt Financed 0.00 Pmt Amt 0.00
First Pmt Ot Rate(%) 0.0000
Employment M 4] > || Wl d]p|n]
Type FULLTIME FULL TIME Primary Collateral
Employer OFSS oFss Asset Class NEW VEHICLE Mileage 0
Occupation OTHER OTHER Year 2015 Wholesale Value 60,000.00
Title TEST TEST Make HONDA Retail Value 60,000.00
Stated Income({Monthly) 15,000.00 12,000.00 Model ACCORD Source INVOICE
Actual Income({Month 0.00 0.00
Stated Time at Employer(Y 77 6/6
Actual Time at Employer(YyY/MM) 0/0 0/0
Total Monthly Income  33,000.00 24,000.00

Ratios
Stated Before DTI
Actual Before DTI
Stated After DTI
Actual After DTI
Stated PTI
Actual PTI

Bureau

Equifax
Experian
Transunion
Score
Grade

! Verify Employment

3.6363
0.0000
3.6363
0.0000
0.0000
0.0000

=

g‘g} Werify Employment

50.0000
0.0000
50.0000
0.0000
0.0000
0.0000
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1.13 Underwriting Compensation Changes

1.13.1

Description

This requirement handles two changes.

Product Release Note

(i) A new input field — ‘Approved Buy Rate’ is added to Underwriting Decision tab. By default, it

displays the pricing rate and can be modified by the User.

A

new system parameter

‘DECISION_BUY_RATE_TOLERANCE’ is introduced to define the ‘Tolerance level’ between the
Approved Buy Rate and Buy Rate. A new Verification Edit (default value — Warning) is provided which
is triggered whenever Approved buy rate is not within the range of “Buy Rate + Tolerance level’
(including boundary values). The ‘Decision APR’ (Annual Percentage Rate) field is displayed in

Decision tab.

(i) A new ‘Compensation’ child tab similar to one in Funding — Contract tab has been added under
Underwriting — Decision tab. The Buy Rate in this new Compensation child tab defaults to ‘Approved
Buy Rate’ in Decision tab. The computations in this new Compensation child tab refer to the
‘Maximum financed Amount’ and ‘Approved Buy Rate’ in Decision tab. ‘Compensation’ calculation
engine considers the default values defined in lookup; while calculating selected compensation
method. In case user clicks ‘copy to decision’, system will recalculate the compensation value based
on parameters selected in ‘Tools > Calculator’. There is no impact / change in behavior of ‘Copy to

Decision’ button, if no compensation selected at underwriting level.

1.13.2

Screen shot

After making changes, screen looks like this:

Origination

Summary

Decision Information

View ~ Format ~ | B
|current |Grade

| [/ € GRADE

« il

Decision Information

Pricing
Pricing
Current
Approved
Decision Term
Pt AT

Decision Margin Rate
Decision Rate

Buy Rate

System Recommandation

Compensation

Compensation Plan

«

Compensation

Compensation Plan
Disburserment Method
Calculation Method

Paid Calc Method
Paid %

Paid Basis

Paid Term

Applicant Requas

Stipulations

view ~ Format ~ | B Freaze

+ | petach

r Decsion

Contract

score
[}

VEHICLE LOAN PRICING-FR

[~

12
2,567.93
FLAT RATE

. 0.0000

4.9900
4.9900
0.0000

@ 2.9900
ve  0.0000

| Detach
Buy Rate

2.9900
1

Chargeback

0.0000

o

Itemizations

Flat At

0.00

Collateral Comments Tracking
Max Advance Amt LTv1|  Max Financed An|
20,000.00 0.00 30,000.00
Status APPROVED
Sub Status BLANK
Down Pt 0.00
Ma 0.0000

Max Fin Amt 30,000.00
Maturity Index FLAT RATE
Maturity Margin Rt 4.9500
Balloon Amt  0.00
Decision APR  0.0000

Trade-In Rate Schedule

Disbursemant

Comp Amt Calculation Method

0.00

Paid Days 0

Max Spread O
Chg OFf Calc Method

Document

verl

LTvz2
0.00

Paid Calc Mathod

fication Correspondence Tools
[ view | o Audit
Decision Term| Decision Rate| Approved
12 4.9900

»
Ga Return

Decision Dt 09/17/2014
underwriter FAJOSEPH

Bureau 1 MONE
B 2 MONE

3 MOMNE

2 C GRADE
Score 0

Collateral Value 0.00

LTVl 0.00

LTVZ 0.00
Comments

Multiple Offars
[ view | = Audie |

0.0000

Ga Retumn
Charge Off % 0.0000
Cha off Basis
Chg OFf Term 0
s 0
% 0.0000
0.00
't 0.00
Rem Comp Amt 0.00
Comp At 0.00
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Before making changes, screen use to looks like this

Product Release Note

Origination [ Close
Decision Information A
(aRetun
Pricing VEHICLE LOAN PRICING-FR Status APPROVED Decision Dt 12/02/2014
Sub Status BLANK Underwiter MAZARUDD
Approved
Decision Term 24 Max Advance % 0.0000 Bureau 3
PmEAME 526,50 Max Advance Amt 12,000.00 Grade AGRADE
Index FLATRATE Max Financed % 0.0000 Score 1000
Index Rate_0.0000 Max Financed Amt 12,000.00 Collateral value 12,000.00
Decison Margn Rate 49900 Maturity Index FLAT RATE LTV1 100.00
Decision Rate 4,990 Maturity Margn Rt 4.9900 L2 100.00
:‘ Buy Rate 2.9900 Baloon Amt. 0.00 Comments q
Down Pt % 00000 Bureau 1 NONE
DownPmt 0.00 Bureau 2 NONE
| System Recommendation Stipulations Hemizations  Trade-In Rate Schedue Sibvention  Mutiple Offers |
System Recommendation
Score 0 Decision BLANK Grade
Requested
Requested Advance 12,000.00 Donn Prit % 0 Baloon Amt 0,00
PmtAmt 0.00 DownPmt 0.00 Signing Dt
Term 24 Approx Prc 0.00 Probable Delvery Dt
Requested Rate 15,0000 Promotion NONE
=
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Product Release Note

1.14 View Application Button

1.14.1 Description

‘View Application’ button to be provided in origination search results screen to view the applications,
even when it is locked by other user. No Add/Edit buttons are visible when User opens an
application using this button.

1.14.2 Screen shot

Origination (Bgclos=
Result/Task Application Entry Search Review Requests (Pending: 0) =
Quick Search
App = ssn Submit
Queue [=] _[B NextApplication
I o New Appiication L Qpen Appication | Unlock Application | I View Appiication \I
Search Results
view » Format | [0 Freeze  ff Detach ol wrap @ vewa [
[ llocd_allowed |Company _|Branch |app # |pate [Title [Product [status |sub status Jorv [orva. =
e uso1 UsRL 0000001462 05/27/2014  ALLJAFFER LEASE VEHICLE NEW REVIEW REQUIRED. 0 o -
| @ uso1 usHQ 0000001486 06/02/2014  TEST SANDEEP LOAN UNSECURED (VR) NEW REVIEW REQUIRED 833.33 833.33
@ uso1 USR1 0000001459 01/01/2014 MEYER MICKEY / TAY LOAN VEHICLE (FR) NEW REVIEW REQUIRED 12 12
@  uso1 usHQ 0000001565 01/01/2014  GABHINAV fNAY  LOAN VEHICLE (FR) NEW REVIEV/ REQUIRED 12 12
@ uso1 USR1 0000001516 05/26/2014  KUMAR ATTH LOAN VEHICLE (FR) NEW REVIEW REQUIRED o o A
(%] uso1 USHYQ 0000001522 05/27/2014 SAM SANDY LOAN VEHICLE (FR) NEW REVIEW REQUIRED 98.36 98.36
@ uson usHQ 0000001485 05/30/2014 S S VVVVV /KHAN NA LOAN VEHICLE (FR) NEW REVIEW REQUIRED 3.2 8.2
@ uso1 usHQ 0000001497 06/09/2014  EINSTEINALBERT  LOAN VEHICLE (FR) NEW REVIEVY REQUIRED 100 100
@ usou usHg 0000001459 06/03/2014  EINSTEIN ALBERT  LOAN VEHICLE (FR) NEW REVIEW REQUIRED 100 100
@ NLO2 NLHQ 0000001416 02/01/2012 1JONES STEVEN f JEM LOAN HOME (VR) NEW REVIEW REQUIRED 100 100
@  uso1 usHQ 0000001492 05/03/2014  TEST SANDEEP LOAN VEHICLE (FR) NEW REVIEV/ REQUIRED o o
@ uso1 usHQ 0000001509 06/17/2014 TESTO1TESTO1 TIARA HOME LOAN (FR) NEW REVIEW REQUIRED 1000 1000 P
@ o HLHQ 0000001500 05/01/2012  KHAN NADEEM / NIG/LOAN UNSECURED (VR) NEW REVIEW REQUIRED 66.66 66,66
@ NLO2 NLHQ 0000001532 05/01/2012 KHAN NADEEM / NIG/LOAN UNSECURED (VR) NEW REVIEW REQUIRED 66.66 56.66
@ oz nHQ 0000001417 05/01/2012  KHAN NADEEM / NIGLOAN CHATTEL (FR) NEW REVIEV/ REQUIRED 66.66 66.66
(=] NLOZ NLHQ 0000001436 05/01/2012 KHAN NADEEM / NIG#LOAN UNSECURED (VR) NEW REVIEW REQUIRED 66.66 66.66
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1.15 Comments Column in Stipulations

1.15.1 Description

Product Release Note

A new column ‘Comment’ is added to Stipulations sub tab next to ‘Stipulations Satisfied’ column.
This is to facilitate User to enter any comments relating to the stipulations in case any of them are not

satisfied.

A verification edit which is by default a warning is added to verify when user marks the field

Stipulations Satisfied as ‘not applicable’.

1.15.2

ORACLE’
Financial Services Lending and Leasing

Screen shot

& Welcome, PHACHODA +  Accessibility g Signout O

Origination [36) Close
Result/Task Underwriting: 0000001430 Search Review Requests (Pending: 0)
Application Z Edit : View | & audit
View~ Format~ | [E Freeze £l Detach Wrap W override 0K Warning OK
Dt App # Status ol il SEs Producer Name Pl lilng Existing Customer Duphcat_e Contact Sales Agent Branch Proj
Code Number Application
[ 01/02/2015 0000001430 NEW - REVIEW RE... REVIEW CA-DD00S : AUTO ... (B18)-768-2100 N [ DEMOSUPR UsHQ Lop
»
Summary Applicant Request Decision Bureau Collateral Comments Tracking Document Verification Correspondence Tools
Decision Information # Edit : view | & audit
View ~ Format v | [EF Freeze G4 Detach Wrap W Boelectpriang | [ v] [ calulate | % ReScore
Current Grade Score|  Max Advance Amt LTV]‘ Max Financed Amt sz‘ Decision Term Decision Rate| Approved Buy Rate Pmt Amt
| [ 0 50,000.00 8333 50,000.00 83.33 24 9.9800 2.0000 0.00
»
System Rec d i It Trade-In Rate Schedule Subvention Compensation Multiple Offers
:| Stipulations
[ sove and stoy | B save and Retum |3 petum ﬂ
view~ Format~ | [Ep Freeze  ffl Detach Wrap T
[Type [Hame [cade | Description Stips Satisfied (Comment B |verified £
[sTPuLATION REASON ¥ ] [ALL v] [app-002 >l [PROVE EMPLOYMENT Yes @ Ho () NA
4
[sTPuLaTION REASOL ¥ [ALL v] [apP-008 x| [NEED TAX RETURNS WITH § Yes @ No () NA
4
[smPuLaTionREASON Y] [ALL v [apr012 x| [NO GAPS IN EMPLOYMENT Yes @ No () NA
4
[smPuLaTionREASON Y] [ALL v] [apr-004 x| [RESIDENCE MUST VERIFY A Yes @ No () NA
N LY
% »
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Product Release Note

1.16 Deal Refresh from Dealer Track

1.16.1 Description

This feature allows to update on previously submitted application using Dealer Track’s add-on
feature titled, “Deal Update.” Deal update allows dealers to update an application by adding a co-
signer, co-applicant or to change previously submitted information without submitting another
application. The most important aspect of this feature is the ability to add collateral after an applicant
has been submitted.

For applications with Origination Stage Code from ‘Decisioned’ up to ‘Verified’, new Sub-Status ‘Deal
Update’ is introduced. System would apply this Sub-Status to the application and change the
Origination Stage Code to ‘Review’. Once Origination Stage Code reaches ‘Funded’ this change
would not be possible

ORACLE' & Vielcome, RMACHRL = Accesshiity g snaut O
Financial Services Lending and Leasing
3] DashBoard Customer Service  Origination (dose
Origination ResultfTask Underwriting: 0000001372 Search Review Requests (Pending: ) S Quick Search =
7 Origination
i Edt | [5]vew | o Auit App 2
- Applcation | e | st |
Simple Agplcaton Enry View v Format v ﬁ Freeze i Detach wirap | @) overide ok [¥] waming 0K . s
Application Entry & [ submit m
Undernriting e T
g ot dop s Status MOnEOn SIS ducer Name | oo M iting Customer | Duplicate Applcation Contact Sales Agent Branch
Funding Code Number | v/Summary
Appication Retrieval W jsy1e 0000001372 APFROVED - DEAL LFREVIEW CA-DO004: VOLKSIH (BIE)684-4444 N |2 ust Req. 17,000.00
Scenario Analysis ‘ n i Advance
Appication Documents Reg. Rate 40000
Image Maintenance Reg Term 50
Reports Sumary  Appicant  Request  Decsion | Bwea  Conbact | Colatrd | Comments  Trading  Doament  Verficton | Comespondence  Tods Grade BGRADE
Producers V1 028

Vendors Decision Information 2t | Even | o aude V2 0.8 E
View » Fomat v | [ Freeze ! Detach Wrap @ £ selectpriong [¢] [ cakiate | gERescore peset Desc 2016 JEEP WRANGLER 41D

ﬂ | leurent |erade | Score| Max Advance At Lva| Max Financed Amt | iTv2]  DedsonTern|  DedsionRate| Approved Buy Rate| . EDR COY RUEICONN
[ I BGRADE 130 17,000.00 0.8 17,000.00 0.8 5 9.3800 2.0000 (=R @
N 5 GRADE &1 0,000.00 500.00 60,000.00 50000 2 138300 2.0000 +Change Status
4 T "
% Stalus | APPROVED - DEAL UPDATE |
Changs Stats
SystemRecommendzton  Stpultions  Itemizations | Tradedln  RateSchedde  Subventon | Compensaton  Multiple Offers m
Itemizations WEINEIIRIEY ~ Add Comment
View = Fomat+ | [ Freeze ] Detach wep | G “aet [
| [temization |+ |requestedamt  [Approved Amt |miscount Rate Comment | -
[ Do PAYVENT - 16,000.00 0.00 B P =
5 - B
Serviding ITMCASH SALES + 12,000.00 0.00 ;| s =
> Collections TTMDOWN PAYVENT PAYOFF + 0.00 0.00 4 Type
o
T ITMDOWN PAYVENT TRADEIN - 000 0.00 Eo
ITM CREDIT INSURANCE LIFE + 750 0.00
?/Tools TTM CREDIT INSURANCE DISABILITY + 0.00 0.00 -
| Setup TTMINSURANCE GAP + 7.0 0.00 B P———
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Product Release Note

Patches and Bugs

Patches from 14.1.0.0.1 to 14.1.0.0.12 were forward ported into this 14.2.0.0.0 Release.

ORACLE



Security Fixes

Product Release Note

Issue# Issue Details Fix Description
1 Document upload feature should have content EXE and SH files will not be uploaded
validation and file extension validation to avoid
malicious files uploaded to the system.
2 Application was recording the server IP address Recording has been removed.
of the user logins.
3 User supplied inputs are not validated by web Appropriate input validations have been
service. added in webservices XSDs to allow
relevant data.
4 Application was echoing the password in the Echoing of the value has been removed
error message.
5 SQL Injection vulnerabilities have been removed | Issue has been fixed by the use of bind
variables in the query.
6 SYSTEM.OUT.PRINT statements have been The statements have been replaced with
removed from database JSPs call to cmnerr_cl_000_01.debug_log. The
statements will be logged either to table or
log file based on configuration and
exceptions will be logged into alert.log
7 Forcible password change when the user logs-in | A new user to OFSLL will have to change
for the first time. the password on first login.
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Product Release Note

Limitations and Open issues

Some of the limitations as well as known open issues within the application are:

Ref No

Bug Details

20137750

When the 'RUN REPORT button is pressed, there is no indication that it has successfully launched
a report request. We are concerned that users will press the button repeatedly.

20137764

Origination — Underwriting - Editing the application and pressing return button takes excessive time
over network.

20145902

Route One producer file not uploading due to recent ssl changes. Route One interface recently
changed their server to no longer allow SSL connections and allow only TLS connections.

19987571

Interface- conversion The issue is while converting the loan using the API process, if multiple
assets are passed, the AVL_TOTAL_VAL is not populated for non-primary assets, for vehicles
marked as primary the AVL_TOTAL_VAL is populated.

19987635

Interface - Conversion when converting an account, if the VIN number is passed with less than 17
characters, the record fails to convert with an exception. An Edit be created used so that the
reason for failure to load is known instead of being unknown.

19882324

Interface - Conversion Account boarding screen not able to manually enter account detail
information.

19943523

Interface - Conversion Accounts boarding process app_mrate that passed in conversion in
API_CONTRACTS get overridden by adc_mrate from pricing.

19888821

Interface - Conversion: When trying to convert accounts thru API interface getting the error cannot
insert NULL into ("IACCOUNTS"."ACC_DLQ_COUNTO_LIFE").

20189740

Origination — Underwriting — Correspondence - Letters-> recipient details - issue in fax/email field.
Go to 3rd row or any row other than first record and Add and save the recipient record for the
correspondence type from DECISION @ FAX/EMAIL. After saving the cursor control moves to the
first record in the master block CONDITIONAL ADVERSE ACTION LETTER instead of staying in 3"
row itself.

20234851

Credit bureau -> Equifax-> Report format details->Addl prod

Do not give any value in the field 'Addl prod'. Give other details and Save the record.

Create an application and do a credit bureau pull for Equifax Go to Bureau->Add on Tab. Add on
details are available. System should not show the Add on details when in report format details,
Addl prod 'ldentity Scan' is not selected.

19163968

WFP-> PRODUCERS ->STATEMENTS -> Statement Block missing under Statements Tab.

19164260

WFP ->PAYMENT BATCH ->POST PAYMENT -> Payment error does not match with the payment
details.

19169790

WFP ->REPORTS -> Reports are not considering the Report Parameters values given. It is
generating the reports by considering as “ALL” for all reports.

20329192

Customer Service ->Maintenance tab. Add a transaction and save it. Do not load the parameters
Add a second transaction and save it. Don’t load the parameter. Click on the first transaction and
click on edit and Click on the load parameter. Control is not going/refresh to the correct transaction
record so displaying the transaction parameters of the other transaction.

20345143

Origination > Underwriting > Summary ->Super Summary section. Once the bureau pull is
complete, exceptions are available in the Bureau->Exception tab. But same Exception information
is missing in the summary widget bureau section.

ORACLE



Annexure A: Environment Details

Product Release Note

Component Deployment | Machine Operating | Software Version
option System
Oracle Financial | Centralized | Application Oracle 10.3.6.0
Services Lending server Weblogic
and Leasing Enterprise
Edition
Oracle SunJDK | 1.7.0_55
Oracle
. Oracle 11.1.1.7
Enterprise _
Linux6.2 | Repository
(64 Bit) Creation Utility
OR
Application 11.1.1.7
Sun SPARC | pevelopment
with Oracle | Framework
Solaris 11
Database (64 Bit) Oracle 11.2.0.3/
Server Database 12.1.0.2.0
Enterprise
Edition
Reporting Oracle Business | 11.1.1.7
Server Intelligence
Publisher
Client Windows 7 | Internet 9.0/10.0/
Machines / Windows | Explorer 11.0*
Vista
Apple Safari 6.0.1
Mozilla Firefox | 24.x
Google Chrome | 25
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*|E 11 support:

Download and apply Patch 18916353 & 20046396 from the Oracle support site. This is a patch on ADF
11.1.1.7 for support of IE 11.

Business Intelligence Publisher:

It is recommended to apply patch 11.1.1.7.140527 for Business Intelligence Publisher. This is a patch on
BIP 11.1.1.7.
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such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system,
integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and
license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not
developed or intended for use in any inherently dangerous applications, including applications that may create a risk of
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